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Alge-Blaster 3 (win)

Publisher: Retail Cost: $44.95
Davidson & Associates, Inc.
P.O. Box 2961
Torrance, CA 90509
(800) 545-7677
www.education.com

System Requirements:
386/16 MHz or faster MS-DOS compatible computer, hard disk with at
least 5 Mb of free space, 4 Mb RAM, Windows 3.1 or higher, VGA card,
mouse, Windows-supported sound accessory (for digitized speech).

Description:
Alge-Blaster Plus is a comprehensive algebra program designed by
teachers of pre-algebra and algebra students. The program focuses on
understanding the algebraic process and developing skills to solve
problems. Specifically, its objectives are: to provide an instructive,
interactive, and motivating format for improving algebra skills, to help
students master the basic steps in solving algebraic equations, to prepare
students to solve algebraic word problems, and to offer practice in basic
graphing skills.

Recommended Uses:
Alge-Blaster 3 can be used as an interactive tutorial for algebra or as a
supplement to an algebra course.

Basic Use:
1. Double-click on the Alge-Blaster 3 program group to open it.
2. Double-click on the Alge-Blaster 3 icon to start the program.
3. Enter your name in the sign-in box and press Enter. The program

starts with a musical introduction which you may skip by pressing
Enter.

4. From the Main Screen you have four choices which are the program's
four activities. You can choose an activity by either clicking on one of
the four buttons or by selecting it from the Activity menu. The
Challenger activity is the main tutorial section of the program. Click
on the Challenger button.

5. Choose a subject from the either the cascading Activity menu or from
the Toolbar.

Notes:
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Algebra Animator (Win)

Publisher: Retail Cost: $ 199.00
LOGAL Software Inc.
125 Cambridge Park Dr.
Cambridge, MA 02140
800-564-2587
www.logal.com

System Requirements:
386 processor or higher
Microsoft Windows 3.0 or higher
Color VGA monitor
5 MB hard disk space
4 MB RAM

Description:
Algebra Animator is designed to foster the ability of students to see
connections between mathematics and the real world and to use
mathematics to analyze and solve real-world problems. Animator uses a
two-dimensional modeling environment in which students create and
observe animations of objects whose movements are determined by
equations and represented by mapping diagrams, tables of values, and/or
graphs.

Recommended Uses:
Animator can be used as an open-ended environment or with the
accompanying chapters of student activities and pre constructed Animator
files.

Basic Use:
1. Choose 1st Look from the Algebra Animator group.
2. Follow the directions in this tutorial to learn how to use Algebra

Animator.
3. Try an activity from the Activity section of the manual. This will

guide you through using the predefined files included with Animator.

Notes:
Additional users can be purchased for $69.00 apiece. Network versions
are available for $1200 for 16-20 users and $1300 for 21-30 users.

Be sure to check out their web site for LOGAL EXPRESS, an online way
to check out any of their products.
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Algebra I HomeworkTutor (DOS)

Publisher: Retail Cost: $48.00
Missing Link Software
10 Leonard Street
New York, NY 10013
(800) 222-9296

System Requirements:
• IBM PC or compatible
• DOS 3.3 or later
• 640K RAM
• CGA, EGA, or VGA
• 2 Mb available on hard drive

Description:
This program is an introductory approach to basic algebra skills. Skills
addressed in this program include signed arithmetic, combining like
terms, multiplication of monomials, monomials and the distributive
property and laws of exponents. The student can either study from an
extensive number of problems provided by the software program or enter
his/her own. As the problems are solved, each step must be completed
accurately before the student is allowed to continue on to the next step.
Hints are provided should the student need them and examples of solved
problems are available. The problems are not solved for the student, but
the program allows the student to work through them and solve them on
their own.

Recommended Uses:
This program is not intended to be an entire algebra course. The authors
of this program recommend using it in conjunction with an algebra
textbook. A book is better for learning new math vocabulary which is
used in HomeworkTutor and the exercises in textbooks are better
designed than the random problems HomeworkTutor creates. The intent
of the program is to supplement a regular course, therefore some
instruction is expected as well.

Basic Use:
1. At the C> type cd \hwt then press Return to change to the Algebra I

directory.
2. Type hwtalgl then press Return to start the program.
3. Follow the tutorial starting on page 3 of the manual to learn the

basics of the program.
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4. Try some of the exercises in the algebra textbook to see how a student
could use this program to help with homework.

Notes:
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Algebra Smart (Win)

Publisher: Retail Cost: $ 28.95

The Princeton Review
50 Mall Road, Suite 210
Burlington, MA 01813
800-566-7737
http://www.review.com

System Requirements:
486 DX processor or better
8 MB RAM
Double-speed CD-ROM drive or faster
SVGA monitor and video card with 256 colors
Sound card and speakers

Description:
Algebra Smart covers a full year of algebra curriculum with 12 lessons
covering 60 subject areas and includes 137 videos. A glossary of terms is
included as well as diagnostic tests. Scores are tracked and progress
reports can be generated. The program is very interactive, using
multimedia to get ideas across.

Recommended Uses:
This program could be used to supplement curriculum or as a self-paced
tutorial.

Basic Use:
1. Insert the CD-ROM and the program automatically starts. If the CD-

ROM is already in, choose Algebra Smart from the Princeton program
group.

2. If this is your first time using the program, enroll and follow the on-
screen directions for getting started. The introduction explains in
detail how to use all of the features in Algebra Smart.

Notes:
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Dr. Brain, The Lost Mind of (Win)

Publisher: Retail Cost: $ 39.95
Sierra On-Line
Direct Sales
PO Box 3404
Salinas, CA 93912-9850
(800) 757-7707
www.sierra.com

System Requirements:
IBM Compatible computer, 486SX/20 MHz CPU, CD-ROM drive, 1 MB
hard drive space, 3 MB RAM free, Windows 3.1 compatible sound card,
SVGA video board (256 colors @ 640 X 480), audio speakers or
headphones, mouse.

Description:
Users reconstruct Dr. Brain's mind that he lost in an experiment using
seven different types of intelligence to solve ten puzzle areas. A section of
his mind is restored when users complete a required number of puzzles in
a specific area.

Recommended Uses:
This software, through a game format, will provide many different tasks
for students with learning disabilities or head injuries. It is designed to
help students develop strategies in the following areas: Verbal/Linguistic,
Logical/Mathematical, Visual/Spatial, Bodily/Kinesthetic, Musical,
Interpersonal Communications, and Intrapersonal Communications.

Basic Use:
1. Double-click on the Dr. Brain icon to start the program. If you do not

wish to see the introductory credits, just click the mouse button once
to advance to the next level.

2. You will be presented with the screen to start a new game or to
restore a game you started previously. Choosing a new game will lead
you to an introductory cartoon that explains the situation and
introduces the characters. To start a new game, click on the New
Game page then enter your name by clicking on the letters. To
continue a previous game, click on the Restore page, then select your
name.

3. If you selected New Game, follow the introduction to learn how to
play.
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Dr. Brain, The Time Warp of (Win)

Publisher: Retail Cost: $ 39.95
Sierra On-Line
Direct Sales
PO Box 3404
Salinas, CA 93912-9850
(800) 757-7707
www.sierra.com

System Requirements:
IBM Compatible computer, 486SX/20 MHz CPU, CD-ROM drive, 1 MB
hard drive space, 3 MB RAM free, Windows 3.1 compatible sound card,
SVGA video board (256 colors @ 640 X 480), audio speakers or
headphones, mouse.

Description:
Users reconstruct Dr. Brain's mind that he lost in an experiment using
seven different types of intelligence to solve ten puzzle areas. A section of
his mind is restored when users complete a required number of puzzles in
a specific area.

Recommended Uses:
This software, through a game format, will provide many different tasks
for students with learning disabilities or head injuries. It is designed to
help students develop strategies in the following areas: Verbal/Linguistic,
Logical/Mathematical, Visual/Spatial, Bodily/Kinesthetic, Musical,
Interpersonal Communications, and Intrapersonal Communications.

Basic Use:
1. Double-click on the Dr. Brain icon to start the program. If you do not

wish to see the introductory credits, just click the mouse button once
to advance to the next level.

2. You will be presented with the screen to start a new game or to
restore a game you started previously. Choosing a new game will lead
you to an introductory cartoon that explains the situation and
introduces the characters. To start a new game, click on the New
Game page then enter your name by clicking on the letters. To
continue a previous game, click on the Restore page, then select your
name.

3. If you selected New Game, follow the introduction to learn how to
play.
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Encarta 98 Deluxe (Win)

Publisher: Retail Cost: $ 69.95

Microsoft Corporation (Headquarters)
One Microsoft Way
Redmond, WA 98052-6399
(800) 426-9400
www.microsoft.com

System Requirements:
• Multimedia PC or compatible with 486 DX 50 MHz or higher

microprocessor, 8 Mb of RAM, 30 Mb of available hard disk space,
double speed or faster CD-ROM drive, audio board, and SVGA display
with 256 colors or higher.

• Microsoft Windows 95 or later.
• MS-DOS 3.1 or later.
• Microsoft Mouse or compatible pointing device.
• Headphones or speakers.

Description:
Encarta 98 is an interactive multimedia encyclopedia with thousands of
articles. It includes audio clips, and high-resolution graphics and videos.

Recommended Uses:
Encarta 98 can be used as a research tool to write reports.

Basic Use:
1. To start Encarta, insert the CD-ROM into the drive or choose the

Microsoft Encarta icon if it is already in the drive.
2. Click on the Overview title to learn about Encarta and how to

navigate.

Notes:
Encarta now comes in two versions: Encarta and Encarta Deluxe which is
a two CD set. Monthly updates can be obtained through the Internet on a
subscription basis.
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Factory (Win)

Publisher: Retail Cost: $79.95
Sunburst Communications/Wings for Learning
101 Castleton Street
Pleasantville, NY 10570-0100
(800) 321-7511
www.nysunburst.com

System Requirements:
Windows 3.1 or higher, 386 machine, 4MB RAM, VGA color monitor, hard
drive, sound capability optional.

Description:
The Factory is designed to teach problem solving strategies. It focuses on
several strategies, including working backwards, analyzing a process,
determining a sequence and applying creativity.

The first level of the program allows students to experiment with three
machines. The students' creativity can be expressed in the second level of
the program where they can design products, try to produce them using
combinations of the three machines, and then challenge other students to
produce them. In the third level, students are asked to look at a final
product, and then work backwards to determine what process took place
to construct the product. In order to perform the task, students must
know the function of each machine and devise a sequence which will
produce a final product.

Recommended Uses:
The Factory teaches strategies such as:

1. Working Backwards - When working backwards, you solve the
problem by determining what the final result should be and then
working backwards to find what steps will give you that result.

2. Analyzing - Breaking down the problem, solving it in parts if
possible, and identifying necessary and unnecessary information.

3. Looking for a Sequence - Finding order and discovering
relationships.

4. Visual Reasoning - The ability to analyze an object that is visually
presented.

5. Rotation - Understanding and applying the mathematical concept
involving the number of degrees in a turn.
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Basic Use:
1. Double-click on the Factory program group to open it.
2. Double-click on the Factory icon to start the program.
3. Choose the Help menu to read instructions about how to run the

program.
4. Scan the curriculum for classroom use in the manual for ideas on how

to use the program with a group. Also, be sure to examine the
Workbook Modules and Workbook Materials in The Factory
Workbook.

Notes:
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Geometry Blaster (Win)

Publisher: Retail Cost: $ 39.95
Davidson & Associates, Inc.
P.O. Box 2961
Torrance, CA 90509
(800) 545-7677
www.education.com

System Requirements:
Windows 95 or Windows 3.1x; 486/66 MHz or faster; 640x480; 256-color
SVGA graphics; 8 MB RAM; Windows-compatible sound card, mouse,
hard drive; double-speed CD-ROM drive.

Description:
Geometry Blaster covers an entire year's worth of geometry through a
planetary search of hidden geometric principles. Hundreds of practice
problems are presented and hyperlinked lessons and a special on-line
glossary are available to guide users through their journey. Covers a full
year of geometry featuring an interactive tutorial approach.

52 subject areas are covered including: triangles, angles, Pythagorean
Theorem, properties of polygons and circles, coordinate and
transformational geometry, proofs, theorems, logic, perimeter, area,
volume, similarity, ratio and proportion.

A Video Chalkboard graphically presents over 50 lessons with step-by-
step instruction and examples. The Geometry Handbook is available at
all times and contains 52 lessons. An on-line glossary includes more than
150 important geometry terms along with illustrations and examples.

Recommended Uses:
This program could supplement geometry course-work or provide needed
background for trigonometry and other courses.

Basic Use:
1. Insert the CD-ROM into the drive. The Geometry Blaster screen will

automatically appear. Click on the Play button to begin.
2. Listen to the introduction if this is your first time playing or click the

mouse to skip it. Sign in, then click on the Go button.
3. Choose an activity from the Activity menu or click on the geometry

textbook to choose a lesson. Each lesson begins with instructions for
that section.
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Hot Dog Stand (Win CD ROM)

Publisher: Retail Cost: $59.95
Sunburst Communications
101 Castleton Street
Pleasantville, NY 10570-0100
(800) 321-7511
www.nvsunburst.com

System Requirements:
Windows 95; CD ROM drive.

Description:
Hot Dog Stand is a simulation that utilizes the computer's unique ability
to randomly generate problems and events. It is designed to motivate
students to become actively involved in developing a wide variety of
mathematical and practical skills. The simulation requires planning and
record-keeping, as well as judgments based on computational skills, to
make as much money as possible while managing a hot dog stand at a
series of football games.

Recommended Uses:
In the course of the simulation, the student must buy, price, and sell
varying quantities of hot dogs, sodas, and potato chips. A great many
variables—including weather, type of game, the related crowd size,
product quality, product price, and "money in the bank"—influence the
realistic decisions that ultimately affect each student's success with the
program.

The random generation of variables assures that a student—or group of
students—can use the same program over and over again.

Basic Use:
1. Open the Hot Dog Stand program from the Programs option on the

Start menu.
2. Listen to the verbal instructions which familiarize the listener/viewer

with the principles of using Hot Dog Stand.
3. Enter name in Register box.
4. Select Beginner option when prompted to choose playing level. This

level, useful for the novice, leads the user through the game by
flashing the object which must be selected to begin the next activity.

5. In ordering supplies, the user can use a calculator, or an estimator,
and at the end, write a check.
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6. Set prices.
7. Open the Hot Dog Stand.
8. Check the progress summary for sales.
9. Evaluate what was right about the sales and what was wrong: e.g.,

not enough courtesy kits, prices too high, poor quality (cheap supplies
bought to save money).

Notes:
The intermediate and advanced levels of the game incorporate random
events which the user must accommodate, just as one must accommodate
random events in real life.
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Math Blaster Mystery 1.1c (Win)

Publisher: Retail Cost: $ 44.95

Davidson & Associates
PO Box 2961
Torrance, CA 90509
(800) 545-7677
www.davd.com

System Requirements:
Super VGA or VGA graphics, Windows 3.1 or higher, 4 MB RAM for
Windows 3.1, 8MB RAM for Windows 95, 33MHz 486 or faster, Double
speed CD-ROM drive for CD version, Mouse, hard drive, Windows
compatible sound card required for speech and sound effects.

Description:
Math Blaster Mystery builds pre-algebra, logical-thinking and word
problem skills in a game format of searching Dr. Dabble's creepy mansion
for a stolen brain. There are three levels of math difficulty and over 150
different word problems which are read out loud in digitized speech.
Subjects cover estimation, proportion, order of operations, and equation
completion.

Recommended Uses:
This program can be used individually or in group settings to supplement
math curriculum.

Basic Use:
1. Insert the CD into the drive.
2. Open the Great Brain Robbery program group, then open the Great

Brain Robbery application.
,3. The best place to start learning about the program is to go to Math

Blaster Help from the Help menu.
4. Choose an activity from the activity menu and try to solve the

problems.

Notes:
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Math for the Real World (Win)

Publisher: Retail Cost: $ 29.95
Davidson & Associates, Inc.
P.O. Box 2961
Torrance, CA 90509
(800) 545-7677
www.education.com

System Requirements:
486/66, 8 MB available RAM, 256 color super VGA graphics, Windows
compatible sound card, double-speed CD-ROM drive, 10 MB free hard
disk space, Windows 3.1/95.

Description:
Math for the Real World uses a simulation of a musical group working its
way to creating a music video. Players solve math problems along the
way to make their savings grow with correct answers. Real world
situations along the road trip are used to develop the following concepts:
fractions, decimals, percents, measurement, patterns, volume, charts and
graphs, logic and critical thinking, money, time, and weight.

Recommended Uses:
This program could be used to reinforce basic math skills in an engaging
multi-media environment that is geared to contemporary music.

Basic Use:
1. Insert the CD-ROM into the drive. The program will startup

automatically.
2. Click on the Play button to begin playing. Sign in and click on the

Start New Tour button. A brief explanation of the game and the
contract will appear.

3. Be sure to read all 4 pages of the contract to learn how to play the
game then click on the accept button to begin playing.

4. Once the game begins, each task is explained. Answer the questions
to make more money. Don't forget to stop for food and gas every now
and then.

Notes:
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Math Heads (Win)

Publisher: Retail Cost: $ 29.95
Theatrix Interactive, Inc.
1250 45th St.
Emeryville, CA 94608
info@theatrix.com
http://www.theatrix.com

System Requirements:
486/25 MHz
8 MB RAM (5 MB available RAM)
10 MB available hard disk space
256 color support
Double-speed CD-ROM drive
Windows 3.1 or Windows 95
16-bit Windows-compatible sound card
Mouse and speakers

Description:
Math Heads develops strategies for problem solving in an interactive
television format. Users can personalize the game by choosing a head,
headgear, and a body or even scan in their own image. Each channel
presents a different math activity designed to give practice in that area.
This program is very interactive and adapts to each user in amazing
ways.

Recommended Uses:
Math Heads was designed to develop pre-algebra skills in the areas of
solving word problems, making mental calculations and estimations,
computing fractions, decimals, percentages and equivalencies, and using
logical thinking skills.

Basic Use:
1. With the CD-ROM inserted, choose Math Heads from the Theatrix

program group. Listen to the lengthy intro explanation.
2. The first step is to create your character. Follow the on-screen

prompts to do so. You can always return to this screen by choosing
channel 1 with the remote control.

3. Once you have your character, you can choose a channel or go to the
preview channel (2) to see where you would like to go.

4. Follow the on-screen instructions to complete each task.
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Math Master (Win)

Publisher: Retail Cost: $ 29.95
Accurate Research, Inc.
762 Palomar Avenue
Sunnyvale, CA 94086
408-523-4788
http://www.drcdrom.com

System Requirements:
486 DX-33 or better processor
8 MB RAM, 16 recommended
640x480 VGA display capable of 256 colors
Sound Card
Mouse
Microsoft Windows 3.1 or later
CD-ROM drive, double speed or better

Description:
Math Master is a 5 disc set that covers a broad range of subject areas.
Disc titles include: Pre-Algebra, Algebra 1, Algebra 2, Geometry, and
Trigonometry. Students are presented with problems and shown how
they are solved. Problems can be read out loud with the click of a button.
They can then take a quiz to test their understanding.

Recommended Uses:
Mathematics could be used as backup information for students in the
form of self-paced tutorials.

Basic Use:
1. Place the CD ROM of your choice into the CD ROM drive.
2. Open the Math Master Programs Group from the Start Menu.
3. Choose the icon corresponding to the CD ROM you inserted.
4. The first screen shows the chapters for this disc. Click on the chapter

you wish to explore.
5. Click on the buttons of the controller in the right side of the screen to

hear the text read to you.
6. Follow the on-screen directions to complete the lesson.

Notes:
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Math Resource Center (Win)

Publisher: Retail Cost: $ 32.95
Aces Research, Inc.
510-661-2093
acesxprt@aol.com

System Requirements:
A 386 or higher multimedia PC with 4 MB of RAM, VGA graphics with
256 colors, MS-DOS 5.0 or later, Windows 3.1 or Windows 95, a mouse
and CD-ROM drive.

Description:
The Math Resource Center is a comprehensive group of math lessons
covering five topic areas: Algebra, Geometry, Trigonometry, Calculus,
and Statistics. Over 1,500 problems take students from beginner to
advanced lessons. The approach is essentially a textbook online with
related problems to be solved. Users switch between a Textbook Window
and the main problem solving window where they can get hints or
solutions to problems.

Recommended Uses:
The Math Resource Center can be used as self-paced instruction or as
supplemental material for course-work.

Basic Use:
1. Insert the CD of your choice into the drive.
2. Open The Math Resource Center program group and open the Help

file. Browse the contents to learn how to operate the application.
3. When you are familiar with the navigation of the application, open

the application corresponding to the disc you inserted.
4. Choose the Practice or Text button to begin.

Notes:
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Mathematics (Win)

Publisher Retail Cost: $ 37.95

Pro One Software
P.O. Box 16317
Las Cruces, NM 88004
505-523-6200

System Requirements
IBM PC or compatible, CD ROM drive, Windows 3.1 or higher, Windows
95 or higher.

Description
Mathematics is a 5 disc set that covers over 250 subject areas. Disc titles
include: Pre-Algebra, Algebra 1, Algebra 2, Geometry, and Trigonometry.
Students are presented with problems they can either solve themselves,
get tutorial information on, or see the problem worked out. Short video
segments of an instructor supplement the lessons.

Recommended Uses
Mathematics could be used as backup information for students in the
form of self-paced tutorials.

Basic Use
1. Place the CD ROM of your choice into the CD ROM drive.
2. Open the Sofsource Program Group from the Program Manager.
3. Choose the icon corresponding to the CD ROM you inserted.
4. The first screen shows the chapters for this disc. Double click on the

chapter you wish to explore.
5. Choose the lesson you wish to view and double click on it.
6. Follow the on-screen directions to complete the lesson.

Notes
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Microsoft Word 97 (Win)

Publisher: Retail Cost: $ 339.00
Microsoft Corporation (Headquarters)
One Microsoft Way
Redmond, WA 98052-6399
(800) 426-9400
www.microsoft com

System Requirements:
Computer with 486 processor or greater
Microsoft Windows 95 or later, and a 1.2 Mb or greater floppy disk drive
Hard drive with at least 8 MB space available and 35 MB for complete

installation
At least 8 MB RAM
VGA Monitor or better resolution
Mouse
CD-ROM drive

Description:
Word is a powerful document processing environment. This version
includes the basic features of several applications users generally think of
as separate from their word processor, e.g., charting with the graph
function, graphics with a draw function, mathematical equation writing
with an equation editor, and built-in spell check, grammar check, and
thesaurus.

Recommended Uses:
Word can be used to accomplish nearly every word processing task. This
Windows version adds ease of use to its list of powerful features. For
students with learning or cognitive disabilities, the menus and icons of
the graphical user interface may be more intuitive and thus easier to use.
Built-in interactive spell check, autocorrect, thesaurus, and grammar
check should also help these students. For students with physical
disabilities, having an equation editor and draw function built-in should
also prove to be very useful. Students with mild visual disabilities will
benefit from having larger print available within the program by
changing the size of the type or using the zoom feature. All users will like
the extensive on-line help.

Basic Use:
1. Start up Word by choosing it from the Start Menu.
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2. From the Help menu, choose Microsoft Word Help. The paperclip
agent appears with some suggestions.

3. Type a topic of interest into the text field, then click Search. The
help topic or topics the agent thinks you might want to look at are
listed.

4. Pick a topic by clicking on it and follow the directions. Many topics
include wizards that walk the user through a tutorial.

Intermediate Use:
Real-Time Spell Check Function
When this option is selected, Word puts a wavy red line under any word
not in its dictionary. The user can right click on an underlined word to
see what list of suggested correct words the program has selected. If the
correctly spelled word is present, clicking on it will automatically cause it
to replace the misspelled word. To turn on this function in Word do the
following:

1. From the Tools menu select Options.
2. Click on the Spelling & Grammar tab.
3. Under the Spelling area, check the box next to Check spelling as

you type.

Grammar Checker
The use of a grammar checker may be helpful for students with some
prior knowledge of grammar rules and writing style conventions.
However, for students not able to benefit from grammar checker use,
creating a custom grammar check profile for them is a consideration. It is
possible to turn off or on every feature within the grammar check
program. Perhaps only one grammatical rule could be checked, that of
subject-verb agreement. Students could work in instructor-created text
especially constructed to effectively trigger the grammar checker. This
focused activity could have a two-fold benefit: students could experience a
grammar checker working efficiently, and they might also learn more
about subject verb agreement—either from the activity itself or from
actively reading all the Explain screens if their reading levels allow it.

How to Customize the Grammar Checker
1. From the Tools menu select Options.
2. Click on the Spelling & Grammar Tab.
3. Make sure the Check Spelling as You Type function is not checked;

keep the use of the Spell Check as a dedicated activity. From the
Grammar section, select the box next to Check Grammar as You
Type.

4. Click the Settings button to see the grammar checker options.
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5. Deselect all grammar and style options except Subject-Verb
Agreement.

6. Click OK.

The grammar checker now has been modified. The next task is to write
text with subject-verb errors which effectively trigger the grammar check
rules.

An Auto-Correct Function
When this function is on, Word will automatically correct "adn" to "and"
as the user types. Word comes with many common typing errors entered
into the autocorrect dictionary. It also is very easy to add one's own
personal common typing errors.

Directions for turning on this function and for adding personal choice
typing errors:

1. From the Tools menu, select Autocorrect.
2. Make sure that Replace Text as You Type is selected.
3. Enter a frequent typing error into the Replace field, and in the

With field enter a correctly spelled version of the word.

Outline Function
It is useful for some students to work in the outline mode for pre-writing
activities, brainstorming and making a list of related ideas. The outline
function allows topics to be dragged, or moved up or in through the tool
bar, and students can develop a coherent document structure.

To begin Outline mode, go to the View Menu and choose Outline view.
Note the new tool bar. To return to Normal view, go to the View menu
and select Normal.

Use Word Document Templates or Wizards
Microsoft Word comes with many useful document templates. They can
be accessed through the New dialog box. Also accessible from this dialog
box are numerous "Wizards" which lead the user through customization
processes for different document types.

Notes:
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SkillsBank 4 (win)

Publisher Retail Cost: $1,245.00
Skills Bank Corporation
Park View Center 1
7104 Ambassador Road
Baltimore, MD 21244
(800) 451-5726
www.skillsbank.com

System Requirements
Skills Bank 4 will work in Windows 3.1, Windows 95, NT; purchasable as
a single-user CD, 5-user lab pack, or as a network version (50-user or
unlimited in one building).

Description
Skills Bank 4 is an all-new version of the basic SkillsBank 3 program.
The activities are the same, but the format is different. The program now
comes on CD ROM only. Critical thinking strands are incorporated
throughout each subject area. The 200 plus topics are contained in 19
subject areas. The program comes contains these basic content areas:
reading, language, writing, basic mathematics, intermediate
mathematics, and information skills.

Recommended Uses
Skills Bank software is useful for any student needing a brief, basic
tutorial review in major basic skills areas. This new version comes with a
complement of in-depth activities which can be purchased. There are two
Practice series and a MathCheck starter kit currently available.

Major Components:
Diagnostic and prescriptive pre-tests
Basic skills lessons
Quizzes
Thinking skill lessons

New Features:
• Voice and sound guide students through lessons and provide an extra

modality for learning.
• Lessons on Internet fundamentals are included.
• Mathematics activities have been revised and there are 40 new

activities.
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• Purchasable Language Practice Series provides 22 add-on lessons with
open-ended interactive practice on all concepts in SkillsBank
Language Series.

• Purchasable Computation Practice Series features 24 add-on lessons
with randomly generated problems in an open-ended interactive
setting.

• Enhanced teacher reports.
• Purchasable mathematics worksheet generator (MathCheck) which

offers add-on libraries of additional math content.

Notes
Pricing:
Single User Set (Basic Skills) $1245.00
5-User Lab Pack $2490.00
50-User Net Site $4980.00
Unlimited Net Site $7470.00
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The Trig Explorer (Mac/Win)

Publisher Retail Cost: $ 39.95
Cognitive Technologies Corp.
3601 East West Hwy.
Chevy Chase, MD 20815
301-907-3955
http://www.coetech.com

System Requirements
Mac OS 7.1 or higher or Windows 3.1 or 95, 8 Meg. RAM, 10 Meg HD
space,
Sound card recommended.

Description
The Trig Explorer contains lessons that use animated and engaging
illustrations and real world applications. The Trig Explorer builds many
bridges from math to science, history, and real world phenomena. It uses
voice, music, creative animations, and many interactive activities.

Recommended Uses
Could be used as supplemental information or as an introduction to
trigonometry topics.

Basic Use
1. Insert the CD-ROM.
2. Choose the Trig icon to start the program.
3. Choose a topic from the list on the left side of the screen and follow

the on-screen directions.

Notes
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Winning at Math - Study Skills Computer
Evaluation (DOS)

Publisher Retail Cost: $179.95
Academic Success Press, Inc. (for site license)
P.O. Box 25002, Box 132
Bradenton, FL 34206
(941) 359-2819

4915 80th Avenue Circle East
Sarasota, FL 34243

System Requirements
• IBM PC or compatible computer
• 128K RAM

Description
This program evaluates students' math study skills based on responses to
questions and provides positive suggestions to improve study skills.
Questions and answers can be printed for later reference.

Recommended Uses
Any student may benefit from this study skills evaluation, especially if
the suggestions are followed.

Basic Use
1. Insert the 3 1/2" program disk into drive B.
2. At the C> type B: then press Enter to change to the B drive.
3. Type Take Survey then press Enter to start the program.
4. Press Enter when the next screen appears to continue.
5. Type your name then press Enter.
6. Answer the questions with A, B, or C. When the 20th question has

been answered the program will ask you to turn on the printer. When
the printer is on, press Enter to print the questions and suggestions
for improvement.

Notes
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